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Chapter 1  

Introduction 

The Content Author‘s Cookbook is designed to give content authors the information 
they need so that they can use Sitecore CMS to perform their day to day work. This 
cookbook is primarily aimed at introducing new content authors with limited computer 
skills to the tools that Sitecore contains. However, the procedures described in this 
document will also be beneficial for more experienced and technically skilled content 
authors who are unfamiliar with the tools that Sitecore contains. 

Content authors must be able to update existing content on their corporate Web site 
or intranet as well as create new material. This cookbook explains how to perform 
both these tasks with the two editing tools that Sitecore contains — the Page Editor 
and the Content Editor — and demonstrates how to edit existing items and create 
new items with both of these tools. The cookbook also introduces some of the more 
advanced features and functionality that Sitecore contains. 

This Content Author‘s Cookbook contains the following chapters: 

 Chapter 1 — Introduction 
This chapter is a description of the content, aims, and the intended audience of this 
manual.  

 Chapter 2 — Sitecore 
An introduction to some basic Sitecore functionality including item locking and 
formatting. 

 Chapter 3 — Managing Content in the Page Editor 
Step by step instructions for using the Page Editor to create and edit content. 

 Chapter 4 — Managing Content in the Content Editor 
Step by step instructions for using the Content Editor to create and edit content. 

 Chapter 5 — The Rich Text Editor 
Step by step instructions for creating several versions of the same item as well as 
creating different language versions of the same item. 

 Chapter 6 — The Media Library 
Step by step instructions for using the Media Library. 

 Chapter 7 — RSS Feeds 
Step by step instructions for creating RSS feeds. 

 Chapter 8 — Workflows for Content Editors 
Step by step instructions for creating and using workflows. 

 Chapter 9 — Customizing the Interface 
Step by step instructions for publishing content on your Web site. 
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Chapter 2  

Sitecore 

This chapter introduces some of the basic Sitecore functionality. This chapter 
explains how to log in, how item locking works, and describes how roles affect the 
functionality that is available to you in Sitecore CMS. 

This chapter contains the following section: 

 Logging In 

 Roles and Functionality 

 Item Locking 

 Formatting 
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2.1 Logging In  

You must log in to Sitecore before you can edit any of the content on a Web site. 

To log in to Sitecore: 

1. Enter Sitecore after the name of your Web site, for example 
http://www.mywebsite.net/sitecore and the Log in page appears: 

 

2. Select the task you want to perform, enter your user name, password, and click Log in to log 
in and start editing the Web site. 
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3. Alternatively, click Options to see the other options that are available.  

 

4. Select the user interface that you want to use, enter your user name, password, and click Log 
in to log in and start editing the website. 

Note 
In this manual, we use the Sitecore Training Sample Site as our demonstration site. 

Configuring Sitecore on Internet Explorer 

If you have any problems configuring your Sitecore client on Internet Explorer, see the Internet 
Explorer Configuration Reference at 
http://sdn.sitecore.net/reference/Sitecore%206/IE%20Configuration%20Reference.aspx.  

http://sdn.sitecore.net/reference/Sitecore%206/IE%20Configuration%20Reference.aspx
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2.2 Roles and Functionality 

Sitecore contains tools that are suited to both experienced and inexperienced content authors. The 
Content Editor is the editing tool for experienced users. However, depending on the roles you have 
been assigned, the functionality that is available to you may differ from the functionality described in 
this guide. 

For example, a user who has been assigned one set of roles may see the following ribbon in the 
Content Editor: 

 

Whereas a user who has been assigned another set of roles may see much more functionality in the 
Content Editor ribbon: 

 

Furthermore, when you log in to the Sitecore Desktop, the set of applications shown in the Sitecore 
menu also depends on the roles that have been assigned to you. The following images show the 
Sitecore menu for two users who have been assigned a different set of roles: 
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2.3 Item Locking 

Sitecore uses item locking to ensure that two different users can‘t edit the same item at the same 
time. If two or more users somehow managed to edit the same item simultaneously, only the changes 
that were made by the user who clicked Save last will be available. All the other changes will be lost.  

Item locking is a system whereby you lock the item you are editing and prevent other users from 
editing this item until you unlock it again after you have finished editing the item. 

Item locking works differently depending on the tools that you are using. 

 In the Page Editor, you can lock an item before you start to edit it. 

 In the Content Editor, you must lock an item before you can edit it. 

2.3.1 Item Locking in the Page Editor 

In the Page Editor, the way that item locking works depends on the access rights that you have been 
assigned. 

Minimal Page Editor 

If you only have access to the Minimal Page Editor, you do not have access to the ribbon and cannot 
manually lock an item before you edit it.  

In this case, Sitecore checks whether an item is locked or not when you save it. If the item is not 
locked your changes are saved. If the item has already been locked by another user, you receive a 
message informing you that the item has been locked by another user and your changes cannot be 
implemented. 

Limited or Full Page Editor 

If you have access to the Limited Page Editor or the Full Page Editor, you can edit an item directly on 
the page without locking it. When you save the item, Sitecore locks it for you. If the item has already 
been locked by another user, you receive a message informing you that the item has been locked by 
another user. 

Alternatively, you can click Lock or Edit to manually lock the current item before editing it.  

 

When an item has been locked by you, it is noted in the My Items command. 

 

In the previous image, the user has locked two items.  

When you have finished editing the item, you must remember to unlock it so that other users can edit 
it if they need to. 
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Unlocking Items 

You must remember to unlock items that you have locked.  

To unlock an item, select the item and click Edit or Lock 

If you have locked and edited numerous items, you can easily lose track of them all.  

To see which items are still locked by you, in the Edit group, click My Items: 

 

The My Items dialog box lists all of the items that you have locked.  

To unlock one or more items select them and click Unlock. To unlock all the items, click Unlock All.  
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2.4 Formatting 

In Sitecore, the formatting of the content that is displayed on a Web site is generally controlled by the 
style sheets that have been defined for the Web site by the administrators, designers, programmers, 
and so on. 

This means that as a content author you do not have to worry about how the material you are 
responsible for is presented to the reader and can concentrate on the quality of the material.  

You can of course influence the style by making some text bold or italic and so on. Furthermore if you 
know how to write HTML, you can edit the code and thereby influence the way that the content is 
presented. In general you can concentrate on the material that is presented and ignore the way that it 
is formatted. 
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Chapter 3  

Managing Content in the Page Editor 

This chapter introduces the Page Editor and the functionality it contains. It contains 
detailed descriptions of how to edit an existing item including how to edit simple text 
fields and rich text fields. There is a description of how to manage images in the Page 
Editor. There are also detailed instructions on how to create new items. 

This chapter contains the following sections: 

 The Page Editor 

 Editing an Item in the Page Editor 

 Creating a New Item in the Page Editor 

 Deleting Content 
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3.1 The Page Editor 

Content authors are generally focused on the quality and accuracy of the material displayed on the 
Web site and not on the design, style, and layout of the site. For this reason most content authors 
prefer to work in a program that is designed to meet their needs and not those of the developers and 
designers who create the Web sites. 

With this mind, Sitecore CMS allows content authors to edit and create items directly on the Web 
page with the Page Editor. The Page Editor is the simplest of the editing tools that Sitecore contains. 
It is designed for inexperienced content editors who edit and write content items directly on the page. 
It is a WYSIWYG editor (what you see is what you get) and limits the amount of functionality that is 
presented to the user. 

When you log in to the Page Editor, the functionality that is available to you can vary depending on 
the security roles that you have been assigned and the customizations that have been carried out on 
Web site you are accessing. 

When you log in to the Page Editor, two buttons are displayed at the top of the Web page: 

 

You can then navigate to the page that you want to edit and click Edit to open the Page Editor in edit 
mode. 

The functionality that you have access to in the Page Editor can vary greatly. As a minimum you can 
expect to see some buttons at the top of the Web page: 

 

If you have been given more access rights, you might be able to use a ribbon of commands. The 
ribbon you are presented with could look something like this: 

 

This ribbon contains all the functionality available in the previous screenshot plus a little more. 

When you are editing an item, you can click Ribbon to temporarily hide the ribbon and give yourself 
some more space to work with or have a less confusing layout. Click Ribbon again to display the 
ribbon. 



Sitecore CMS 6.2 Content Author's Reference and Cookbook   

 

Sitecore® is a registered trademark. All other brand and product names are the property of their respective holders. The 
contents of this document are the property of Sitecore. Copyright © 2001-2010 Sitecore. All rights reserved.  

Page 15 of 115 

If you have been given full access to the all the functionality contained in the Page Editor, you will be 
able to use all the commands in this ribbon: 

 

This ribbon consists of six tabs each with its own collection of commands. 
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3.2 Editing an Item in the Page Editor 

As mentioned earlier, the Page Editor is the simplest of the editing tools that Sitecore contains and 
has been designed for content editors who want to do their editing directly on the page.  

The Page Editor is a WYSIWYG editor that allows you to see the changes that you make directly on 
the page. This makes it easier for inexperienced users to control the changes that they make to the 
content items they are responsible for. 

In the Page Editor, you can edit: 

 Simple text fields, date fields, and so on —fields that you edit on the page and have no extra 
functionality associated with them. 

 Rich text fields — fields that you edit in the Rich Text Editor. 

 Word fields — fields that you edit in Microsoft Word. 

 Media items — any kind of graphical item or sound file. 

Note 
In all of the procedures described in this manual, we use the Sitecore Training Sample Site as the 
demonstration Web site.  

3.2.1 Editing a Simple Text Field 

To edit a simple text field: 

1. Log on to the Page Editor. 

2.  When the Page Editor opens it displays two buttons: 

 

3. Navigate to the item that you want to edit. 

4. Click Edit to start editing the item. 

5. In the item, select a simple text field that you want to edit.  

 

6. Edit the text directly on the page. The text field automatically expands to fit the text you enter.  

7. When you are finished editing the text, you can start editing another text block or click Save to 
save the changes, Save & Close to save the changes and exit editing mode, or Close to close 
the item and exit editing mode without saving the changes. 
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3.2.2 Editing a Rich Text Field 

A rich text field gives you more control over how the text appears on the Web page. 

To edit a rich text field: 

1. Select a rich text field and Sitecore displays some extra options. 

Depending on your installation, the options can vary from 

 to  

You can either edit the text directly on the page or in the Rich Text Editor. 

2. When you edit a rich text field directly on the page, you can not only edit the text but may also 
be able to format it. You can make the text bold, italic, and underlined. 

You can also insert a link or an image into the item. 

Inserting a Link 

To insert a link into a rich text field: 

1. Click the link button  to open the Insert a Link dialog box. 

 

2. In the Insert a Link dialog box, expand the content tree and select the item that you want to 
create a link to. 

3. Click Link to create the link. 
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4. If the item that you want to link to is an image or media file, click the Media Items tab. 

 

5. Expand the content tree and select the media item that you want to link to. 

6. Click Link to create the link. 

Inserting an Image 

To insert an image into the rich text field you are editing: 

1. Click the Insert Image button  to open the Insert Media Item dialog box. 

 

2. Expand the content tree and select the image or media item that you want to insert. 

As you can see you can also insert other types of media into the item. These could be 
animations, film clips, sound files, and so on. 

3. Click Insert to insert the image into the rich text field.  

Uploading an Image or File 

If the media file, that you want to create a link to, is not available in the media library, you must upload 
it to the media library. 
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To upload an image or file to the media library: 

1. In the Page Editor, click the Insert Image button : 

 

2. In the Insert Media Item dialog box, click Upload to open the Upload a File dialog box: 

 

3. In the Upload a File dialog box, click Browse to locate the file you want to use. When you 
select the file, it is automatically uploaded to the Sitecore Media Library. 

When the media file is available in the Media Library, you can create a link to it or use it to illustrate 
your Web site. 

3.2.3 Editing a Rich Text Field in the Rich Text Editor 

You can also edit rich text fields in the Rich Text Editor. 

1. Select the rich text field that you want to edit: 
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2. Click Edit Text to open the text in the Rich Text Editor: 

 

3. You can now edit the item in this window.  

The Rich Text Editor gives you access to more functionality. You can: 

 Insert and delete links to other parts of the Web site and to external Web sites. 

 Insert pictures or other media items. 

 Insert symbols into the text 

 Paste text from Microsoft Word into the item.  

If you prefer, you can use Microsoft Word to write the text you want to use in the item 
and paste it into the Rich Text Editor. 

 Find and replace text in the item. 

4. When you are finished editing the item in the Rich Text Editor, click Accept to save your 
changes. 

Furthermore, you can also view the item in HTML format, if you have the necessary expertise and feel 
comfortable editing the text in that format.  

Note 
Your Sitecore system administrator controls the functionality that is available in the Rich Text Editor. If 
you need more functionality, ask your administrator to make it available to you. 

For more information about using the Rich Text Editor, see Chapter 5 ‗The Rich Text Editor.‘ 

3.2.4 Editing a Word Field in the Page Editor 

Sitecore also supports using Microsoft Word as the text editor. People who are familiar with Word may 
prefer using this tool to edit lengthy pieces of content. These Word fields are defined in the template 
by the developer who creates the Web site.  

You can edit Word fields in the Page Editor. 

Important 
You must have Microsoft Word 2007 installed on your computer to edit Word fields in Sitecore. 

Sitecore Word fields are only supported on Internet Explorer 7 and later. 
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Configuring Word Fields 

If you are using Internet Explorer 8, the first time you access a Word field in Sitecore, you will receive 
an error telling you that your security settings won‘t let you run ActiveX controls on the page. 

 

If this is the case, you must configure Internet Explorer to support Word fields in Sitecore. 

To configure Internet Explorer to support the Word fields: 

1. Ensure that you only have one instance of Internet Explorer open. 

2. In Internet Explorer, click the Tools (ALT-T), and then click Internet Options.  

 

3. In the Internet Options dialog box, click the Security tab, and then click Trusted Sites. 
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4. In the Security level for this zone section, click Custom level, and the Security Settings - 
Trusted Sites Zone dialog box appears. 

 

5. In the Security Settings - Trusted Sites Zone dialog box, in the Settings section scroll 
down to the ActiveX controls and plug-ins node. 

6. In the Automatic prompting for ActiveX controls section, click Enable. 

7. Click OK to accept the changes that you made. 

Now when you access a Word field in Sitecore, you are prompted to install an ActiveX 
component. 

 

8. Click Install to install the component. 

When the component is installed, you can edit the field in Word. 

Note 
After you have installed this ActiveX component, you should consider undoing these changes and 
going back to the original security settings. 

Editing a Word Field 

To edit a Word field in the Page Editor: 

1. In the Page Editor, move the mouse over a Word field and it displays a small Word icon. 
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2. Click Edit to open a new window displaying the content of this field in Word.  

 

You have access to all the functionality that Word contains.  

3. To insert a Sitecore link to another item on your Web site, click Insert a Link. 

4. To insert an image from the Media Library, click Insert Media. 

5. To insert an image that is not in the Media Library, use Word‘s functionality. 

You should upload any images that you want to use regularly to the Media Library. 

6. When you are finished editing the Word field, click Accept to save your changes and close the 
window. 

7. To close the window without saving your changes, click Reject. 

8. In the Page Editor, save your changes and unlock the item. 

For more information about Word, see Microsoft‘s documentation. 

Depending on how your Web site has been configured, you can also edit Word fields directly on the 
page. If your Web site supports inline editing, all of the functionality of Word is available in the inline 
editing pane. 

 

1. Click Toolbar to display or hide the ribbon in Word. 

2. To insert a Sitecore link to another item on your Web site, click Insert a Link. 
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3. To insert an image from the Media Library, click Insert Media. 

For more information about configuring Word fields, see the Presentation Component XSL Reference 
manual. 

3.2.5 Editing a Graphical Item 

You can also use the Page Editor to edit any graphic items that are displayed on the Web site. When 
you select an image, you are presented with some additional options:  

 

You can: 

 Edit the link that the image contains – if there is one. 

 Select the image to be displayed. 

 Edit the properties of the image. 

Once again, the options that are available to you can vary from installation to installation. 

Editing the Link in an Image 

To edit the link in an image: 

1. If the picture is a link, click Edit Link: 

 

2. In the left-hand pane of the Internal Link dialog box, select the item that the link should open.  

You can only link to another item in this Web site and cannot link to another Web site. 

3. The Internal Link dialog box contains the following fields: 
 

Field Value 

Link Description A description of the link. 

Anchor The name of the anchor on the page you want to link to. The 
browser will scroll directly to this point on the page. 
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Field Value 

Target Window Whether the link should use the same browser window, 
another browser window, or a custom window. 

Custom If you select Custom in the target Window field, you specify 
the custom window here. 

Style Class The style class that you want to use. 

Alternate Text An alternative text that will be displayed when you move the 
mouse over the image. 

Query String A query that will be added to the link. 

4. Fill the fields in with the appropriate information. 

Changing the Image 

To change the image that is displayed in the rich text field: 

1. In the Page Editor, select the image that you want to change.  

2. Click Choose Image to open the Media Browser dialog box: 

 

The Media Browser dialog box lets view all of the items that are currently available in the 
Sitecore Media Library. 

3. Select the image that you want to use and click OK. 

This new image is inserted into the current item. 

4. In the Page Editor, click Save to save the changes, Save & Close to save the changes and 
exit edit mode, or Close to close the item and exit edit mode without saving the changes. 

Editing the Properties of an Image 

To edit the properties of the image: 

1. In the Page Editor, select the image. 
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2. Click Properties to open the Image Properties dialog box. 

 

3. In the Alternate Text field, enter the text to be displayed when you move the mouse over the 
image. 

4. In the Dimensions section, specify the dimensions that the image should be displayed in — if 
they differ from the actual size of the image. 

5. In the Space section, specify how much space should be placed around the image. 
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3.3 Creating a New Item in the Page Editor 

As a content author, you not only have to edit content but also create new content items and insert 
them into the Web page where you want them displayed. 

The ways in which you can create items in Sitecore can vary depending on the security roles that you 
have been assigned and the way your Web site has been customized. 

3.3.1 Inserting Items  

When you log on to the Page Editor, you should navigate to the page that you want to edit. When you 
click the Edit button at the top of the page, you are presented with all of the editing tools that are 
available to you on this Web site. 

To insert a new item onto the page: 

1. Click Insert to open the Insert dialog box. 

 

The type of item that you can create will vary depending on where you are on the Web site. If 
you are on the front page, you can insert a new section and depending on the type of section 
you are on, you can add appropriate items to that section. 

2. Select the type of item that you want to insert. In this example, you insert a new section. 

3. In the Item Name field, enter the name of the section that you want to insert. 
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4. Click Insert to create the new section and a section is added to the Web site: 

 

As you can see, the new section contains no items and the sidebar contains the same text as 
the Home page. 

When you create a new item, it is automatically locked to prevent other users from editing it. 

5. To add an item to the Products section, click Insert and the Insert dialog box contains the 
following options: 

 

6. Select the item that you want to create. 

7.  In the Item Name field, enter the name of the new item and click insert. 
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These items have different designs and allow you to present different information on the Web 
page. 

 

Both the items you can select and the presentation possibilities that they give you are 
determined by the design and style that has been implemented on your particular Web site. 

8. You should now edit the items and the section you have inserted and add text, images, 
sidebar text, and so on. 

When you are finished editing the new items, you must unlock them. 

To unlock the items: 

1. In the Edit group, click My Items to see a list of all the items you have locked. 

 

2. In the My Items dialog box, select the items that you have finished editing and click Unlock to 
unlock the item. If you have finished editing all the items, click Unlock All to unlock all the 
items. 
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3.4 Deleting Content 

Content authors must delete items and content from time to time. This is a very simple task in the 
Sitecore Page Editor. 

3.4.1 Deleting an Item 

To delete an item from the Web site: 

1. Navigate to the item that you want to delete. 

If you want to delete an item, navigate to that item. 

If you want to delete a sub-item, navigate to the sub-item in question and not just the link to it 
that is shown on another item. 

2. Click Delete to remove the item or section. 

Once again, depending on the customizations carried out on your Web site and the way the 
Page Editor has been configured, the Delete button may be located on the ribbon or at the top 
of the screen. 

3. If you try to delete an item that contains sub-items, a message will appear informing you that 
that the section contains sub-items and that these items will be deleted along with the section.  

 

If you want to save any of the items, you must move them to another section. 

4. Click OK to delete the item and its subitems. 
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Chapter 4  

Managing Content in the Content Editor 

This chapter introduces the Content Editor and the functionality it contains. It contains 
detailed descriptions of how to edit existing items. There is also a description of how 
to manage images in the Content Editor. There are detailed instructions on how to 
create new items and how to delete items. 

This chapter contains the following sections: 

 The Content Editor 

 Editing an Item in the Content Editor 

 Creating New Items in the Content Editor 

 Deleting Items in the Content Editor 
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4.1 The Content Editor 

The Content Editor has been designed for more experienced content authors who feel comfortable 
working with a computer, Microsoft Word, and are familiar with Sitecore and the functionality that it 
contains. 

The Content Editor is a large application but its appearance and the functionality that it contains 
varies depending on the roles that have been assigned to the user, the local security settings and the 
amount of customizations that have been carried out on your installation. 

The Content Editor gives the user access to an array of functionality that meets the needs of the more 
experienced content author.  

The functionality that you have access to in the Content Editor can vary greatly. As a minimum you 
can expect to see: 

 

If you have been given more extensive access rights, you will probably have access to more 
commands and more tabs: 

 

If you have complete access to the Content Editor, it will look something like this: 

 

4.1.1 The Page Editor vs. the Content Editor 

When you log in to the Content Editor, the items that make up your Web site are presented to you in a 
very different way than they are in the Page Editor. In the Page Editor, you see the items as they are 
presented on the Web site. In the Content Editor, you see the items as objects in the content tree and 
when you select an item it is presented to you as a list of fields that you can edit. 
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For example, the Products section of the Sample Web site looks like this in the Page Editor: 

 

You can edit all of the items that appear on the page — text, graphics, logos, links, and so on. 

When you open the Products section in the Content Editor, it looks like this: 

 

As you can see, it is presented as a list of fields that you can edit. Furthermore, the fields you are 
presented with are only those that belong to the Products item itself. The Sitecore logo, the Home 
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Products item, and so on are all separate items and must be edited independently of each other in the 
Content Editor. 

4.1.2 The Content Tree 

One of the main features of the Content Editor is the content tree that it uses to present all the items 
that have been created for the Web site. 

 

The Sitecore content tree has a similar structure to the one used in Windows Explorer. In Sitecore 
objects and groups are not represented by standard folder and file icons but by many different icons. 
You can expand and open every group in the Sitecore content tree just as you can the folders in 
Windows Explorer. When there is a plus ‗+‘ beside an icon, it contains sub items and can be 
expanded. When there is a minus ‗-‘ beside an icon, it has already been expanded and when there is 
no symbol, the item contains no sub items. 

Searching in the Content Tree 

There is a search function associated with the Sitecore content tree. This helps you find items quickly 
and can be particularly useful in very large Web sites and in sites that you are unfamiliar with. 

To search for an object: 

1. In the content tree, select the object that you want to search from. This is the starting point for 
your search. 

The Sitecore search engine searches the entire content tree. However, the search results list 
the items that are found after this starting point above the items that are found before this 
starting point. 

The Sitecore search engine does not support wildcards. 
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2. In the Search field, enter the value that you want to search for. This can be any character, 
number, word, and so on. 

 

3. Click the Search button  or press ENTER to perform the search and the results are 
displayed. 

 

Adding an Extra Criteria 

Sometimes you might need to refine your search by entering extra criteria. 

To add extra criteria to your search: 

1. Click the drop-down arrow  to open an extra pane: 

 

2. If you want to search for an object by its name, enter the value in the Name field. 

Starting point for the search 

Folder the item is stored in 
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3. To change the field that you search in, click the name of the field and a list appears displaying 
the names of all the fields in the current item. 

 

4. To add an extra criterion, in the Add Criteria field, enter the name of the criteria. 

 

5. Click Add Criteria to add the new criterion to the list. 

6. You can then click the name of the new criteria and select a field name from the list that 
appears. 

The results of the search are displayed in the Search Results pane. The items that were 
found below the current item are displayed first. 

Removing the Extra Criteria 

To remove the extra criterion, click the criterion you want to remove and then click Remove at the 
bottom of the menu that appears. 

4.1.3 Locking in the Content Editor 

In the Content Editor, you must lock an item before you can edit it.  

Locking an Item 

To lock an item: 

1. In the Content Editor, navigate to the item that you want to edit. 
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2. On the Home tab, click Edit to lock the item. 

 

When you lock the item, the functions and commands that are available to you are activated 
in the Content pane. 

 

3. You can now start editing the item. 

Unlocking an Item 

When you have finished editing the item, you must remember not only to save the changes but also to 
unlock the item so that others users can edit it. 

To unlock the current item, click Edit. 

As a content author, you often have to make extensive changes to many items on the Web site. This 
can mean that you have to lock many items and keep them locked to ensure that your changes are 
implemented consistently across all the items. 

Sitecore keeps track of all the items that are locked to ensure that nobody else can edit them but it 
also keeps track of all the items that have been locked by each individual user.  
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To unlock the items you have locked: 

1. In the Content Editor, click the Review tab. 

 

2. In the Locks group, click My items: 

 

The My Items dialog box lists all of the items you have locked. You can have locked these 
items during the current session or during previous sessions. 

3. Select the items that you are finished editing and click Unlock to unlock them or click Unlock 
All to unlock all the items. 
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4.2 Editing an Item in the Content Editor 

As mentioned earlier, experienced content authors feel more at home with the advanced functionality 
that is available in the Sitecore Content Editor. 

In the Content Editor, you can edit all of the fields that an item contains — rich text fields, Word fields, 
image fields, and so on.  

Note 
You must lock an item before you can edit it in the Content Editor. 

In all the procedures and tasks described in this chapter, it is assumed that you have already locked 
the item.  

4.2.1 Editing a Rich Text Field in the Content Editor 

After you have selected an item in the content tree, you can edit it. 

To edit an item in the Content Editor: 

1. In the Content Editor, locate the item that you want to edit in the content tree. 

 

2. In the Content pane, locate the field that you want to edit. 
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3. If you want to edit a single line or multiple line text field, you can do it directly in the field: 

 

4. When you want to edit a rich text field, you cannot edit it directly in the field:  

 

5. Click Show Editor to open the Rich Text Editor: 

 

The Rich Text Editor gives you access to more functionality. You can: 

 Insert and delete links to other parts of the Web site and to external Web sites. 

 Insert pictures or other media items. 

 Insert symbols into the text. 

 Paste text from Microsoft Word into the item.  

If you prefer, you can use Microsoft Word to write the text you want to use in the item and 
paste it into the Rich Text Editor. 
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 Find and replace text in the item. 

Note 
The functionality that is available in the Rich Text Editor is controlled by your Sitecore system 
administrator. If you need more functionality, ask your administrator to make it available to 
you. 

Furthermore, you can also view the item in HTML format, if you have the necessary expertise 
and feel comfortable editing the text in that format.  

6. When you are finished editing the item in the Rich Text Editor, click Accept to save the 
changes you have made to the field. 

7. In the Content Editor, scroll down through the item and expand all of the bands and check 
that all of the fields contain the right content. For example, does the sidebar contain the 
appropriate text? 

 

8. Click the Review tab and in the Proofing group, click Spelling to start the spell checker. The 
spell checker runs through all the text fields in the item. 

9. When you have finished editing the item, click Save to save the changes you have made to 
the item and then click Edit to unlock the item so that other users can edit it if they need to. 

Note 
The spell checker only checks the current item. If you have edited several items, you must open them 
individually and run the spell checker. 

For more information about using the Rich Text Editor, see Chapter 5 ‗The Rich Text Editor.‘ 

4.2.2 Editing a Word Field in the Content Editor 

You can also edit Word fields in the Content Editor. 

Important 
You must have Microsoft Word 2007 installed on your computer to edit Word fields in Sitecore. 

Sitecore Word fields are only supported on Internet Explorer 7 or later. 

If you are using Internet Explorer 8, the first time you access a Word field in Sitecore, you will receive 
an error telling you that your security settings won‘t let you run ActiveX controls on the page. 

To learn how to configure Internet Explorer 8 to run this ActiveX control, see ―Configuring Word 
Fields‖ on page 21. 
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To edit a Word field: 

1. In the Content Editor, open the item you want to edit. 

 

2. Click Edit to open a new window displaying the content of this field in Word. 

 

This window gives you access to all of the functionality in Word. 

3. To insert a Sitecore link to another item on your Web site, click Insert Link. 

4. To insert an image from the Media Library, click Insert Media. 

5. To insert an image that is not in the Media Library, use Word‘s functionality. 

You should upload any images that you want to use regularly to the Media Library. 

6. When you are finished editing the Word field, click Accept to save your changes and close the 
window. 

7. To close the window without saving your changes, click Reject. 

8. In the Content Editor, save your changes and unlock the item. 

For more information about Word, see Microsoft‘s documentation. 
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4.2.3 Working with Graphics 

As a content editor, you will often have to change or edit the media items that are displayed on your 
Web site.  

Changing an Image 

To change an image: 

1. In the Content Editor, locate the item that you want to edit in the content tree. 

 

2. In the Content pane, click Browse to open the Media Browser dialog box: 

 

When the Media Browser opens, it displays the image that is already shown in the item you 
are editing. 

3. Locate the image that you want to use, select it, and click OK.  
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4. The image you selected is now used in the item you are editing. 

 

Uploading an Image 

If the image you want to use is not available in the Media Library, you can easily make it available by 
uploading it to the Media Library. 

To add an image to the Media Library: 

1. In the Content pane, click Browse to open the Media Browser dialog box. 

2. In the Media Browser dialog box, click Upload: 

 

3. In the Upload a File dialog box, click Browse and navigate to the image that you want to add 
to the Media Library. 

The image is automatically uploaded to the Media Library and you can now use it on your 
Web site. 

Editing the Properties of an Image 

After you have added an image to an item in the Content Editor, you can edit the properties of the 
image. 
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To edit the properties of the image: 

1. In the Content pane, scroll to the field containing the image. 

 

2. Click Properties to open the Image Properties dialog box: 

 

3. In the Alternate Text field, enter the text that you want to be displayed when you move the 
mouse over the image. 

4. In the Dimensions section, specify the dimensions that the image should be displayed in — if 
they differ from the actual size of the image. 

5. In the Space section, specify how much space should be placed around the image. 

Editing an Image 

You can also use Sitecore to edit the image if you need to.  



Sitecore CMS 6.2 Content Author's Reference and Cookbook   

 

Sitecore® is a registered trademark. All other brand and product names are the property of their respective holders. The 
contents of this document are the property of Sitecore. Copyright © 2001-2010 Sitecore. All rights reserved.  

Page 46 of 115 

To edit an image: 

1.  Scroll to the field that contains the image. 

 

2. Click Edit Image to open the image in the Image Editor: 

 

3. In the Image Editor, you can crop, resize, flip and rotate the image. 

If you need to do more to the image, you should use a proper image editor such as 
Photoshop or Paint Shop Pro and then upload the image to the Media Library again. 

4. When you are finished editing the image, click Save and close the Image Editor to return to 
the Content Editor. 

All the changes that you make are applied to the version of the image that is stored in the 
Media Library and not just the copy shown on your Web page. 

5. In the Content Editor, click Refresh to see the changes that you made. 

6. If you want to remove the image, click Clear. 
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4.3 Creating New Items in the Content Editor 

There are several ways to create new items in the Content Editor. 

You can: 

 Create a new item 

 Duplicate an existing item 

 Copy an item to another location.  

 Create an item based on a template. 

In the Content Editor, when you insert a new item, it is generally created as a sub item of the current 
item. However, you can also create a new item at the same level as the current item. You cannot 
create an item that is at a higher level than the current item. 

The following sections describe how to use the Sitecore ribbon to create, copy, move, duplicate and 
delete items. You can also access all of this functionality by right-clicking in the content tree. 

 

4.3.1 Creating a New Item 

You can easily create a new item as a subitem of the current item. 

Inserting a Sub-Item 

To insert a new sub-item: 

1. In the Content Editor, locate the item for which you want to create a new sub-item. 
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2. In the Insert group, click one of the item types that is displayed: 

 

3. If the item type you want to insert is not displayed, click the scroll arrows in the Insert group 
to find the type of item you want. 

Alternatively, in the Insert group, click the drop-down arrow  and select the subitem from 
the list that appears: 

 

4. In this drop down list, you can select a subitem or a sibling. A sibling is an item on the same 
level as the current item. 

To insert an item at the same level as the current item, in the Insert a New Sibling section, 
click Site Section. 

In this example, we add a new product category to the list. This new category is a subitem of 
Products and can contain its own subitems. 

5. Select the type of subitem that you want to create and a dialog box appears prompting you to 
name the new item: 

 

6. Enter a name for the new item. 
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The new item is now added to your Web site.  

 

As you can see, the new item has been created as a subitem of products and has been 
automatically locked. 

Every new item that you create is automatically locked and opened for you. You must unlock 
them before other users are allowed to edit them. 

7. Edit the new item. Scroll down through the fields and add an image, text, and so on. 

When you have finished editing the item, you can add a new subitem to it. 

4.3.2 Duplicating an Existing Item 

Sitecore lets you duplicate existing items.   

To duplicate an existing item: 

1. In the content tree, locate the item that you want to duplicate. 

In this example, we will duplicate the Wash-o-matic product and then move it to the new 
product category that we just created. 

2. On the Home tab, in the Operations group, click Duplicate and a dialog box appears 
prompting you to name the new item. 

3. Enter a name for the new item and it is added to the content tree: 

 

As you can see, the new item has been added at the same level as the item you duplicated. It 
also contains all of the same text, images, and so on as the original item. 

4. Edit the new item and enter the text, images, and so on that you want to be displayed in this 
item. 

When you have finished editing the item, you can move it to the correct location. 
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Moving an Item 

To move an item: 

1. In the content tree, locate the item that you want to move. 

2. On the Home tab, in the Operations group, click Move To. 

 

3. In the Move Item To dialog box, select the location that you want to move the item to. 

4. Click Move to move the item to the new location. 

 

4.3.3 Copying an Item to another Location 

You can also create a new item by copying an existing item to the location where you want the new 
item to belong. 

To copy an item to another location: 

1. In the content tree, locate the item that you want to copy. 
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2. On the Home tab, in the Operations group, click Move To. 

 

3. In the Copy Item To dialog box, select the location that you want to copy the item to. 

4. Click Copy and the item is copied to the specified location.  

 

5. Edit the new item. 

6. On the Home tab, in the Rename group, click Rename: 

 

7. Enter the new name of the item. 

4.3.4 Creating an Item Based on a Template 

If you have been given sufficient access rights, you can also create an item based on a template. 
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To create an item based on a template: 

1. In the content tree, locate the item that you want to create a subitem for. 

2. On the Home tab, in the Insert group click the scroll arrow  and select Insert from 
Template. 

 

3. In the Insert from Template dialog box, select the template that you want to use to create the 
new item. 

4. In the Item Name field, enter a name for the new item. 

5. Click Insert and the item is added to the content tree. 

 

6. Edit the item. 

7. Save your changes. 
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Previewing Your Changes 

When you have finished editing all the new items that you have created you might like to see how 
these new items will look on your Web site.  

To see a preview of your changes: 

1. Click the Publish tab. 

2. In the Publish group, click Preview to see how the item looks. 

 

A new browser window opens displaying the current item. You can then browse the Web site 
to see all the changes that have been made. 

The following changes have been made to the sample site: 

 The Novelty Products category has been added to the product category list. The Products 
page contains a Novelty Products entry. 

 The novelty items, Clown Shoes, and so on, have been created in the novelty products 
category. The Novelty Products page lists all of the products that we created items for. 

 Each of the products that you created has its own page in the Web site. 

When you are satisfied with all the changes that you have made, unlock all the items that have been 
locked during this session. 
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4.4 Deleting Items in the Content Editor 

Content authors must delete items and content from time to time. This is a simple task in the Content 
Editor. 

4.4.1 Deleting an Item 

To delete an item from the Web site: 

1. In the content tree, locate the item that you want to delete. 

2. On the Home tab, in the Operations group, click Delete. 

Alternatively, you can right-click the item in the content tree and click Delete in the shortcut 
menu that appears. 

The item is deleted from the Web site. 

3. If you try to delete an item that contains sub-items, a message will appear informing you that 
that the section contains sub-items and that these items will be deleted along with the main 
item. 

 

If you want to save any of the items, you must move them to another part of the Web site. 

4. Click OK to delete the item and its subitems. 
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Chapter 5  

The Rich Text Editor 

The Rich Text Editor is the word processing tool that Sitecore uses. This chapter 
explains some of the functionality that it contains. The topics described in this chapter 
include inserting, removing and managing links. 

This chapter contains the following sections: 

 Using the Rich Text Editor 
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5.1 Using the Rich Text Editor 

When you are editing a rich text field in the Page Editor or in the Content Editor, you must use the 
Rich Text Editor. This is a standard word processing tool but in Sitecore we have removed most of the 
formatting functionality because the format of the items that content authors create and edit is 
determined by the style sheets and templates that have been implemented for your Web site. 

However, if you need access to more functionality in the Rich Text Editor, you should contact your 
system administrator and they can make it available to you. 

5.1.1 Editing Text 

When you open the Rich Text Editor, the text in the field you are editing is displayed: 

 

You can now edit the text and use the functionality that is available.  

Pasting Content from Word 

As a content author, you might feel more comfortable writing your content in Word. When you are 
satisfied with the material, you can paste it into the Rich Text Editor. 

To paste content from Word: 

1. Select and copy all the text in Word that you want to paste into a rich text field in Sitecore. 

2. In Sitecore, open the Rich Text Editor.  

3. Click the Paste from Word button  and the text is pasted into the Rich Text Editor. 

When the text is pasted in, all of the information about fonts, sizes, formatting, and so on is 
removed.  

However, if you have created a table in Word, it is pasted in and you must reformat it in the 
Rich Text Editor. 

5.1.2 Inserting, Removing, and Managing Links 

As a content author, you will have to manage links in your content. The Rich Text Editor allows you to 
insert, remove, and edit the links in your content. 

Inserting an Internal Link 

An internal link is a link to another item on your own Web site. 
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To add an internal link: 

1. In the Rich Text Editor, select the image or text that you want to be a link. 

2. Click the Insert Sitecore Link button . 

 

3. In the Insert a Link dialog box, in the Internal Link tab, expand the content tree and select 
the item that you want to create a link to. 

4. Click Link to create the link. 

5. If the item you want to create a link to is an image or media file, click the Media Items tab. 

 

6. Expand the content tree and select the media item that you want to link to. 

7. Click Link to create the link. 

Inserting an External Link 

An external link is a link to another Web site. 

To insert an external link: 

1. In the Rich Text Editor, select the image or text that you want to be a link. 
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2. Click the Hyperlink Manager button . 

 

3. In the Hyperlink Manager dialog box, enter the information about the Web site you want to 
link to. 
 

Field Value 

URL The URL of the Web site. 

Existing Anchor Whether there is an anchor already. 

Link Text The text in the link. You can edit this text here. 

Type The type of link you want to create. 

Target The window that the link should open. 

Tooltip  A tooltip that is displayed when you move the mouse over 
the link. 

CSS Class The style sheet that the link should use.  

Managing Hyperlinks 

You can also use the Hyperlink Manager dialog box to edit existing links, create anchors, and create 
e-mail links.  

An anchor is an HTML code that is used to create a link to another page or to a particular section 
within a page. 

To create an anchor: 

1. In the Rich Text Editor, select the image or text that you want to be an anchor. 

2. Click the Hyperlink Manager button . 

3. In the Hyperlink Manager dialog box, click the Anchor tab. 

 

4. In the Name field, enter the name of the anchor. 
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5. You can now create a link to this anchor by selecting it in the Hyperlink Manager dialog box. 

 

You can also use the Hyperlink Manager to create e-mail links. An e-mail link opens a new mail in 
the program you use to send e-mail, for example, Outlook. The e-mail will be sent to the e-mail 
address specified in the e-mail link. 

To create an e-mail link: 

1. In the Rich Text Editor, select the image or text that you want to be the link. 

2. Click the Hyperlink Manager button . 

3. In the Hyperlink Manager dialog box, click the E-mail tab. 

 

4. In the Address field, enter the e-mail address that the mail should be sent to. 

5. In the Subject field, enter the text that you want to appear in the Subject field in the e-mail. 

Removing a Link 

To remove a link, in the Rich Text Editor, select the link and click the Remove Link button . The 
link is removed and the text becomes ordinary text. 

Note 
You can use the Hyperlink Manager to edit any links that exist on your Web site. 
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Chapter 6  

The Media Library 

This chapter introduces the Sitecore Media Library and the functionality that it 
includes. It describes how you can use the media library to upload and edit different 
types of media items such as images, audio and video. It also covers other more 
advanced options such as versioning. 

This chapter contains the following sections: 

 Overview 

 The Media Library User Interface 

 Uploading Media Files 

 Editing Media Items 

 Media Items and Versioning 
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6.1 Overview 

You use the Media Library to store all the media files that you want to use on your Web site. Media 
files, such as images, can be embedded in a Web page or made available for download by visitors to 
your Web site. 

The Media Library can contain the following: 

 Images — .jpg, .gif, .png and other formats 

 Word documents – .doc and .docx files 

 PDF documents 

 Videos — .MPEG, .WMV and other formats 

 Audio files — .MP3 and other audio formats 

Sitecore has an Image Editor you can use to edit images or you can use your own preferred image 
editing software. 

The Media Library has the following benefits: 

 You can keep all your media files in one place and organize them in a folder structure similar 
to the content tree. 

 You can navigate the content tree or use Sitecore‘s search functionality to quickly find media 
items. 

 It is easy to upload media files to the Media Library. You can use the upload buttons to 
browse your computer for images or simple use the drag and drop dialog box to add media 
files. 

 You can make every media content item and media file versionable. 

Opening the Media Library 

There are a number of ways to open the Media Library: 

Content Editor 

1. Log in to Sitecore as admin and select Desktop. 

2. Click the Sitecore menu, and then click Content Editor. 

3. In the Content Editor content tree, click the Media Library node.  

Alternatively, click Media Library in the bar at the bottom of the Content Editor. 

 

Sitecore Menu 

1. Log in to Sitecore as admin and select Desktop. 

2. Click the Sitecore menu, and then click Media Library. 
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6.2 The Media Library User Interface 

The Media Library user interface consists of the following elements: 

 
Ribbon 
 
 
 
Search 
box 
 
 
 
 
Content 
Tree 
(folder 
structure) 
 
 

 

 
 
 
Options displays 
media item upload 
options 

 Simple 

 Advanced 

 Drag & Drop 
 
Media displays all 
media folders for a 
selected node 

The Ribbon 

In the Media Library, you get the same set of options in the ribbon as you do in the Content Editor, 
although the Insert group allows you to create new media folders and upload media files.  

If you select a media item in the content tree, the Media tab is displayed, which gives you two further 
groups of actions: 

 Write — Save changes 

 Media — View, Edit, Download, Drag & Drop 

Note 
The functionality that you get in the ribbon depends on the user rights you have been assigned by the 
Web site administrator.  

The Content Tree 

Use the content tree or the search box to find media items. Expand nodes in the content tree to see 
all sub-folders and close nodes to hide sub-folders. 

You can view the Media Library content tree from the Content Editor or the Media Library. 

Folders 

The Folder tab displays the options and media contents for a selected folder in the Media Library.  

You should store all your media items in folders and give folders meaningful names.  

An easy way to organize your Media Library folder structure is to mirror the structure of your Web site. 
For example, if your site has four main sections; Home, Products, Jobs and Contact Us you could 
create four folders with the same names to store all your images and other media. This will make it 
easier to locate media items as your site grows and you need to update media items. 



Sitecore CMS 6.2 Content Author's Reference and Cookbook   

 

Sitecore® is a registered trademark. All other brand and product names are the property of their respective holders. The 
contents of this document are the property of Sitecore. Copyright © 2001-2010 Sitecore. All rights reserved.  

Page 63 of 115 

6.2.1 Creating New Folders in the Media Library 

You can create new folders in the Media Library content tree and you can add further sub-folders if 
you wish but try to keep your folder structure as simple and uncluttered as possible. 

To create a new folder: 

1. In the Options pane, click New Folder. 

2. Give the new folder a name such as, My Site Images. 

3. The new folder is displayed at the same level as the other folders in the content tree. 

 
 
 
 
The new 
Media 
Library 
folder 

 

 
 
 
 
 
 
 
 
 
 
Options for 
the new 
folder 
 

4. Select the new folder and you can see the Options section displayed in the Folder tab.  

The new folder has the same upload options as the other Media Library folders. 

Now you can start uploading media items to the new folder. 
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6.3 Uploading Media Files 

In the Media Library, there are three different ways to upload media files: 

 Upload Files 

 Upload Files (Advanced) 

 Drag & Drop 

6.3.1 Upload Files 

Use the Upload Files button to add single or multiple files to the Media Library. 

To upload a single media file: 

1. In the Media Library, in the content tree, select a destination folder, such as the Images 
folder. 

2. In the right-hand pane, in the Options section, click Upload Files. 

 

3. In the Select Files to Upload dialog box, browse to an image folder on your computer and 
select the file that you want to upload. 

 

4. Click Open. 
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During the upload process the following information is displayed: 

 

5. When the upload is complete, the image is displayed Images folder in the Media Library: 

 

6.3.2 Upload Files (Advanced) 

Use the Upload (Advanced) button to upload single or multiple media files to the Media Library. 

To upload multiple files: 

1. In the Media Library, in the content tree, select the Images folder. 
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2. In the right-hand pane, in the Options section, click Upload Files (Advanced). 

 

3. In the Select Files to Upload dialog box, browse to the folder on your computer that contains 
the images you want to upload.  

To select multiple files, press the CTRL key while you select the files. 

4. Click Open. 

5. Before the upload process can start, the following dialog box is displayed: 

 

This dialog box contains the following information and additional upload options: 
 

Field Description 

Filename Displays a list of the files to upload — file name and 
extension, such as, jpeg, gif, or png. 

Size Displays the size of each file in kilobytes. 

Alternate Text Enter an alternative description here if you are 
uploading an image.  

Unpack Zip Archives Select this option if you upload a Zip archive and 
want to unpack the files in the Media Library. 
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Field Description 

Overwrite Existing 
Media Items 

Select this option if you upload a file with the same 
name as a file that already exists in the Media 
Library, and want to overwrite the existing file. 
If you don‘t select this option, a duplicate file is 
created in the Media Library. 

Make Uploaded Media 
Items Versionable 
 

Select this option if you want to make the file you are 
uploading versionable.  
If you don‘t select this option, versioning remains 
switched off. 

Upload as Files 
 

Select this option to store the file in the file system 
rather than in the database. 

6. Click Upload. 

The uploaded images are displayed in the Images folder in the Media Library. 

To Upload Multiple Files in a Batch 

1. Create a .zip archive on your local computer with the files you want to upload. You can 

include sub-folders with files.  

The folder structure is recreated in the Media Library after the files are extracted. 

2. In a Media Library, select the folder that you want to upload the files to. 

3. In the right-hand pane, click the Folder tab and then click Upload Files (Advanced). 

4. In the Select Files to Upload dialog box, browse to the .zip archive. 

5. Click Open. 

6. Select the Unpack ZIP archives checkbox. 

 

7. Click Upload. 

The archive is uploaded and extracted to the Media Library folder you selected. 

6.3.3 Uploading Files with Drag and Drop 

You can also use drag and drop to upload files to the Media Library. Drag and drop is the quickest 
and easiest way to upload media files to the Media Library. You can upload single or multiple files 
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from your computer to the Drag and Drop dialog box. 

 

To drag and drop files to the Media Library: 

1. In a Media Library, select the folder that you want to upload the files to. 

For this exercise, we have created a new folder called My Site Images. 

2. In the Folder tab, click Drag & Drop to open the Drag and Drop dialog box. 
 

 
 
Windows style 
navigation 
 
 
 
 
 
 
 
Details displays the 
name of the current 
folder 

 

 
 
Drag & drop area 
 
 
 
 
 
 
 
 
 
 
 
 
 

3. Open Windows Explorer. 



Sitecore CMS 6.2 Content Author's Reference and Cookbook   

 

Sitecore® is a registered trademark. All other brand and product names are the property of their respective holders. The 
contents of this document are the property of Sitecore. Copyright © 2001-2010 Sitecore. All rights reserved.  

Page 69 of 115 

4. In Windows Explorer, navigate to the folder where the images are stored and select the 
images you want to upload. 

 

5. Position the Windows Explorer window next to the Drag and Drop dialog box.  

6. Drag the selected images from Windows Explorer to the Drag and Drop dialog box. 
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7. The Drag and Drop dialog box displays the images that you want to upload. 

 

8. If the folder already contains images, you must drag the new images to the row of thumbnails 
displayed at the bottom of the dialog box. 

  

9. When you have dragged all the images to the Drag and Drop dialog box, click Done and they 
are copied to the Media Library. 
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10. In the Media Library, Media section, you can now see the images that you uploaded and that 
each item contains a warning. 

 

11. Open the media item for each image and enter some text in the Alt field. This removes the 
warning from each item. 

Note 
Drag and drop functionality is currently only supported in Internet Explorer 7 or later. If you use a 
different browser such as Mozilla Firefox, you can only use the Upload Files and Upload Files 
(Advanced) options to upload files to the Media Library. 

For more information about configuring Internet Explorer to support Drag and Drop, see the WebDav 
Configuration documentation that is available on the Sitecore Developer Network. 
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6.4 Editing Media Items 

In the Media Library, you can edit media items such as images, documents and videos either using 
Sitecore tools such as the Image Editor for images or with other applications that you have installed 
on your computer such as Microsoft Word for documents or Photoshop for images. 

6.4.1 Media Files and Media Items 

Before we start to edit a media item, it is important to understand the difference between media files 
and media items. An image stored in My Pictures on your computer is called a media file. If you 
upload an image file from here to the Sitecore Media Library, it is attached to a media item and from 
then on is referred to as a media item. 

In Sitecore, a media item is just another content item that is composed of several fields and always 
has a file attached to the Media field. To view a media item, click one of the images you uploaded 
earlier. 

A Sitecore media item: 

 

6.4.2 The Image Editor 

To open an image for editing in the Image Editor: 

1. Click the Sitecore menu. 

2. Click All Applications and then click Image Editor. 

3. In the Image Editor window, click Open to open the Media Browser window and select an 
image. 
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The Media Browser 

In the Media Browser window, you can view all the media items in the Media Library. You can 
expand or contract nodes in the Media Library content tree to find the media item you want to edit.  

To upload new media items from the Media Browser window, click Upload or Drag & Drop. 

 

Note 
You can also access the Media Browser from the Content Editor. In a content item, in an Image field, 
click Browse to open the Media Browser window. 

6.4.3 Editing Options 

You can also edit media items locally on your computer. For example, you may prefer to use another 
application to edit images and then upload them again to the Media Library. 

When you click on a media item, the Edit icon in the Media group changes depending on the type of 
file you want to edit. For example, if you click a Word document, you see a pencil as the associated 
icon. 

 

If you click on an image, you see an artist‘s palette. 
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If you select an image item and then click the top half of the Edit command, you open the image in the 
Sitecore Image Editor by default.  

 

You can change the default setting and use a different image editing program. 

To change you default image editor: 

1. In the Media Library, click the Sitecore button  and then click Application Options. 

 

2. In the Application Options dialog box, click the Media tab. 

3. In the Media Edit Button Default section, select the Open editing application installed on 
user’s computer check box.  

4. Click OK to save your changes. 

In the Media group, click the Edit arrow and a drop-down list appears:  

 

 Edit in Image Editor 

 Edit in Local Editor 

These options allow you to override the default setting and select which editor you prefer to use. 
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6.4.4 Using Drag and Drop to Edit Media Items 

You can also use the Drag & Drop dialog box to select a file and edit it. 

However, there are some application options that control how files are displayed and how editing 
works in the Drag & Drop dialog box. 

The Drag & Drop Application Options 

To set the Drag & Drop application options: 

1. In the Media Library, click the Sitecore menu, and then click Application Options. 

 

2. In the Application Options dialog box, click the Media tab.  

3. In the Drag & Drop section, you can specify the display settings for the Drag and Drop 
dialog box.  

There are two options: 

o Show only latest version of files 

If you select this option: 

The Drag & Drop dialog box only displays the latest version of each media file. 

When you open the Drag and Drop dialog box and delete the latest version of a media 
file from there, every version of the file is deleted. 

When you open the Drag & Drop dialog box and edit a media file from there, a new 
version of the file is automatically created when you save your changes. 

o Show versioned files in folders 

If you select this option: 

The Drag and Drop dialog box displays every version of the file in a folder. Different 
folders are created for each language that your Web site uses.  

When you open the Drag and Drop dialog box and delete a version of a media file, 
Sitecore only deletes that version of the file. 

When you open the Drag and Drop dialog box and edit a media item, you must click 
Save As to create a new version of the item. 

4. In the Media Edit Button Default section, you specify which applications should be used to 
edit media files. 

If you select the Open editing application installed on user’s computer check box, 
Sitecore uses the local image editing application that is associated with the different image file 
extensions on your computer. This is the default setting. 

If you clear this check box, the Sitecore Image Editor is used. 
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For more information about Drag and Drop and versioning, see ‗Making Drag and Drop Files 
Versionable‘ on page 79. 

Editing Files from Drag & Drop Window 

You can also edit media items from the Drag & Drop dialog box. 

1. Select a media folder and then open the Drag & Drop dialog box.  

2. In the Drag & Drop dialog box, select the image you want to edit. 

3. Right-click the image, click Open With and then select an image editing application from the 
menu displayed. 

4. The image opens in the image editing program. 

5. Edit the image and save your changes in the editing application. 

If you click Save, the original image file is overwritten. 

If you click Save As, you create a new image in the Drag & Drop dialog box. You do not have 
to upload the file again. All the changes you make to the image are saved in the Drag & Drop 
dialog box. 

6. In the Drag & Drop dialog box, click Done. 
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6.5 Media Items and Versioning 

In Sitecore, a Web site consists of multiple content items. Each content item is made up of fields 
which contain content such as text or images. The Media Library contains media items. Media items 
are just another kind of content item. However, media items have an additional field called Media 
which has an attached media file. 

You can create multiple versions of any content item or media item. There are two types of versions 
you can create: 

 Numbered versions 
For example, you could create a second version of your products page that is to be used 
during a special promotion for a limited period. You could crop an image especially for this 
promotion and then revert back to the original image afterwards. 

 Language versions 
For example, you could create a page in Danish and then create a second version in English. 
You would therefore want an image to display Alt text in both languages. 

As stated earlier, versioning can be applied to content items and media items in the same way. 
However, media files that you upload to the Media Library can also be made versionable. 

Note 
There is no limit to the number of versions you can create in Sitecore. 

Versioned Media Items and Versioned Media Files 

In Sitecore, there is an important difference between versioning media items and versioning media 
files. The following scenarios explain the difference: 

Scenario 1 

You have a media item called diver. In the Content Editor, you click the Versions tab and make a 
second version of this item. 

The image file attached to the Media field (diver.jpg) in this item is not versionable by default.  

You want to create a second version of this item with different Alt text for your company‘s spring 
promotion. The attached media file, diver.jpg is not versionable, so it remains unchanged when 

you create the new version. Only the information contained in item fields can be changed. Regardless 
of how many versions of this item you create, the attached media file (diver.jpg) remains 

unchanged. 

Scenario 2 

You have a media item called diver.jpg. In this scenario, before you upload the file to the Media 
Library, you decide to make it versionable. To do this, in the Upload Files (Advanced) dialog box, 
select the Make Uploaded Media Items Versionable check box. 
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Now when you create a second version of the item you can also keep any changes you make to the 
media file. For example, if you crop or edit the image you can create a second version each time you 
make a change to the file. 

Note 
When you upload new media files to the Media Library, they are unversioned by default. 

6.5.1 Creating a Second Numbered Version of a Media Item 

To make a second numbered version of a media item: 

1. In the Media Library content tree, select a media item. 

2. Click the Versions tab and in the Versions group, click Add, to add a new version. 

In the top right of the diver media item, you can now see a number 2. This is the number of 
the new version of the item that you created. 

 

To switch between versions: 

1. Click the drop-down menu next to the version number and all versions of the selected item 
are displayed. 

 

2. Click the version number you want to view. 

Both numbered and language versions are displayed here. 

You can also click the Versions command in the Versions group to view different versions. 

6.5.2 Working with Versionable Media Files 

Media files that you upload to the Media Library are not versionable by default. However, media files 
can be made versionable after you have uploaded them to the Media Library.  

Why make media files versionable? When you edit an image, you may want the option to revert back 
to an older version of the image. 
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There are two ways you can make a media file versionable:  

 Drag & Drop 

 Upload Files (Advanced)  

Making Drag and Drop Files Versionable 

To make all the media files that you upload to the Drop & Drag dialog box versionable: 

1. Open the Media Library. 

2. Click the Sitecore button and then click Application Options. 

3.  In the Application Options dialog box click the Drag & Drop tab and select the Show only 
latest version of files option.  

You must also change a configuration setting in the web.config file.  

1. The web.config file is stored in the web root folder of your Web site: 
C:\Inetpub\wwwroot\YourSitecoreWebsite\Website 

2. Right-click the web.config file, click Open With, and then click Notepad. 

3. Locate the following setting:  

<setting name="Media.UploadAsVersionableByDefault" value="false" />  

To make every media file that you upload with the Drag & Drop functionality versionable, set 
this value to true. 

The default setting is false. 

4. Save your changes and close the web.config file. 

Changing this setting in the web.config file makes every file that you upload to the Drag & Drop 

dialog box versionable. 

The way the Drag & Drop dialog box functions and displays media files is determined by the 
application options you select in the Application Options dialog box. 

For information about the Drag & Drop application options, see The Drag & Drop Application Options 
on page 75. 

Using Upload Files (Advanced) to Make Items Versionable 

1. In the Upload Files (Advanced) dialog box, select the Make Uploaded Media Files 
Versionable check box. 

 

2. Click Upload. 

This makes the files you are currently uploading versionable. You must select this check box 
every time you upload some files to the media library. 
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Chapter 7  

RSS Feeds 

Sitecore supports RSS feeds. This chapter describes how to set up an RSS feed as 
well as how to subscribe to an RSS feed. 

There is also a description of the client RSS feeds that Sitecore users can subscribe 
to. 

This chapter contains the following sections: 

 Security and Client RSS Feeds 

 RSS Feeds 

 Sitecore Client Feeds 

 Security and Client RSS Feeds 
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7.1 RSS Feeds 

An RSS (Really Simple Syndication) is a Web feed that is used to publish frequently updated material 
— such as blogs, news headlines, audio, video, and so on — in a standardized format. An RSS feed 
can contain either the full text of the material or a summarized version, as well as metadata, such as, 
publishing dates, and authorship.  

RSS feeds allow publishers to syndicate content automatically. Conversely, Web site visitors can 
subscribe to these feeds and automatically receive updates from their favorite Web sites. 

Web site visitor subscribes to a feed by clicking an RSS icon in a browser and this initiates the 
subscription process. The RSS reader checks the user's subscribed feeds regularly to see if there are 
any updates and then downloads the updates that it finds, and provides the Web site visitor with an 
interface to monitor and read the feeds. 

7.1.1 Setting Up an RSS Feed 

In Sitecore, you must use the Content Editor to set up an RSS feed. 

You typically create RSS feeds for content items that are updated regularly — such as news items 
and blogs. In this example, you create an RSS feed for a news item. 

Before you can create any RSS feeds, you must create a folder to store your feed items. 

To create a folder for feed items: 

1. In the Content Editor, in the content tree, select the Home item of the Web site. 

2. On the Home tab, in the Insert group, click the drop down arrow and select Insert from 
Template. 

 

3. In the Insert from Template dialog box, navigate to Templates/Common/Folder. 

4. Give the new folder a name — RSS Feeds. 

Now that you have created a folder to store the RSS feeds in, you can create an RSS feed. 

To create an RSS feed in the Content Editor: 

1. In the Content Editor, select the RSS Feeds folder that you just created. 
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2. In the Home tab, in the Insert group, click Insert from Template. 

 

3. In the Insert from Template dialog box, navigate to Templates/System/Feeds/, and 

select RSS Feed to create a feed based on this template. 

4. In the Item Name field, enter a name for the new feed — News RSS Feed. 

5. Click Insert and the new feed item is created and opened in the Content Editor. 

 

The new feed displays a warning informing you that the feed is empty and that you must 
select an item to include in the feed. 
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6. In the Items field, click Insert Link. 

 

7. In the Item Browser dialog box, expand the Home item and select the News item.  

The News item is included in the RSS feed. 

8. In the Description field, enter a description of the RSS feed. 

9. Save the new item. 

You have now created the News RSS Feed item. 

Now let‘s think about what the feed should contain. The feed should not tell subscribers that the News 
item has been updated; it should contain information about news articles that are created or updated.  

Note 
You can only create an RSS feed to an item that has subitems. If you create an RSS feed to an item 
that does not have any subitems, Sitecore tells you that the feed is empty. 

The next step is to configure how the news articles are presented in the RSS feed. 

To configure how an RSS feed is presented: 

1. In the Content Editor, expand the News item and select one of its subitems. 
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2. Click the Presentation tab. 

 

3. In the Presentation tab, in the Feeds group, click Design. 

 

4. In the Feed Presentation dialog box, specify how the feed is presented to the user who 
subscribes to this RSS feed. 
 

Field Value 

Title Field The item field that you want to appear in the title of the feed. 

Body Field The item field that you want to appear in the body of the feed. 

Date Field The date field that you want to appear in the feed. This could 
be, for example, the date the item was created, updated, or 
the date from which the news applies. 

Preview A preview of the feed. 

5. When you have filled in these fields, click OK. 

In the Feeds group, you can see that the Design button now has a green check mark 
indicating that an RSS feed has been designed for this item. 

6. In the Content Editor, save your changes. 
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Important 
This item and all the other items based on the same template are presented in the same way in the 
feed. 
If some of the subitems are based on a different template, you must also specify how those items 
should be presented in the feed. 

When you have configured how the feed should be presented, the RSS feed item should no longer 
display any warnings. 

Identifying the Template that an Item is Based on 

As a content author, you probably don‘t have access to the template in Sitecore. In fact, you may not 
be aware of the templates that the content items are based on.  

To see which template an item is based on: 

1. In the Content Editor, click the Sitecore button , and then click Application Options. 

 

2. In the Application Options dialog box, select the Quick Info Section option. 

3. In the Content Editor, select the item you are interested in. 

4. The Content pane should now display a section called Quick Info at the top of the item. 

5. Expand the Quick Info section. 

 

6. The Template field tells you which template the item is based on. 
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7.1.2 Creating a Link to the RSS Feed 

After you have defined the RSS feed, you must add a link to the parent content item so that the users 
can subscribe to the feed.  

To add a link to the content item: 

1. In the Content Editor, open the News item. 

2. Scroll down to the Text field and click Show Editor. 

3. In the Rich Text Editor, enter some text for the link. 

 

4. Select this text and click the Insert Sitecore Link button . 

 

5. In the Insert a Link dialog box, navigate to the RSS feed item that you created earlier. 

6. Click Link to create the link. 

7. In the Content Editor, save your changes. 

Previewing the RSS Feed 

Now that you have created the RSS feed for the News item, you can preview it to test that it works 
and looks the way you want it to. 

To preview the RSS feed: 

1. In the Content Editor, open the News item. 

2. Click the Presentation tab and then in the Preview group, click Preview. 
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When you are satisfied that the RSS feed works correctly you can publish it on your Web site. 

Note 
You must publish all the changes you made before they are available on your Web site. 

A More Complicated Scenario 

As we mentioned earlier, if the subitems are based on a different template, you must specify how 
each of these items should be presented in the feed. Let‘s look at such a scenario.  

For example, if you use your Web site to promote your extensive range of products. You might want 
to create an RSS feed for your products page so that customers can keep up to date with the latest 
changes to you product portfolio.  

However, these products are divided into different categories and the Web site uses different 
templates. 

The content tree might look something like this: 

 

To create an RSS feed for your products: 

1. Open the Content Editor. 

2. Select the Products item and set up the RSS feed for this item — it is the parent item. 

3. In the Products item, insert a link to the feed item. 

4. Select one of the product categories and click Presentation, Design to configure how the feed 
is presented for this item. 

If the different product categories use different templates, configure one of each. 

5. Select one of the product items and click Presentation, Design to configure how the feed is 
presented for one of the individual product items. 

Again, if the different product items use different templates, configure one of each. 

6. Select the Products item and click Preview to see a preview of the feed. 

7. When you are satisfied with the feed, publish all the items that you have modified. 
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This RSS feed presents a list of all the product category items and product items listed according to 
date. 

 

7.1.3 Subscribing to an RSS Feed 

When a visitor logs on to the Web site they can easily subscribe to the RSS feed. 

To subscribe to the RSS feed: 

1. Open your Web site in Internet Explorer. 

2. Navigate to the item that you have created an RSS feed for — the News page. 
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3. In the News page, click the Subscribe to an RSS Feed link to open a new page displaying the 
RSS feed. 

 

4. In the RSS Feed page, click Subscribe to this feed. 

 

5. In the Subscribe to this Feed dialog box, give the feed a name and specify where you would 
like to save it. 

6. Click Subscribe to add the feed to your list of feeds. 

7. You have now subscribed to this feed. When you open your browser, you can click Favorites, 
Feeds, and then click the News RSS Feed to see a list of all the news items on this Web site. 
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7.2 Sitecore Client Feeds 

Sitecore also contains a number of client feeds that content authors and other users of Sitecore can 
subscribe to. 

Sitecore contains the following client feeds: 

 Content item feeds 

 Workflow feeds 

 Workflow state feeds 

All of these client feeds are dependent on the items in question being subject to workflows. 

For information about workflows, see Chapter 8, ‗Workflows for Content Editors‘. 

7.2.1 Item Feeds 

To be informed about any changes that are made to an item in Sitecore, you can subscribe to an RSS 
feed for that item. You can subscribe to a feed for any item in the Content Editor content tree. 
However the feed will only contain useful information if the template that the item is based on is 
subject to a workflow. 

To subscribe to a Sitecore item feed: 

1. In the Content Editor, navigate to the item that you are interested in. 

In this example, you are a HR manager who wants to ensure that the text in an item about a 
job vacancy is correct before it is published on your Web site. You therefore subscribe to an 
RSS feed for this particular item. 
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2. Click the Review tab, and then in the Proofing group, click Subscribe. 

 

3. In the Web page that opens, click Subscribe to this feed and add this RSS feed to your 
favorites. 

As you can see the RSS feed does not contain very much information at the moment. However, if a 
content author edits the item and moves it through the workflow, the feed becomes much more 
informative. When the item is edited by a content author, a new version is created and placed in the 
Draft workflow state. 

After a couple of days, the HR manager decides to check the RSS feed. 

In Internet Explorer, in the Favorites panel, click the Feeds tab, and then click the link to the item 
feed. 
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This Web page contains some information about the item, including: 

 The name of the item. 

 Its current workflow state. 

 The workflow history of the item. 

 A table showing the differences between the new version and the old version of the item. 

It also contains some workflow commands that let you move the item through the workflow — if you 
have the appropriate permissions. 

Sitecore Workflow Feeds 

Sitecore also contains some workflow feeds that you can subscribe to. 

To subscribe to a workflow feed: 

1. Open the Workbox. 

 

2. To subscribe to the workflow feed, click the RSS feed button for the workflow.  

This client feed keeps you up to date on the entire workflow and is useful for administrators 
and super users who have access to every workflow state that the workflow contains. 
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3. To subscribe to a workflow state feed, click the RSS feed button for the workflow state.  

This client feed keeps you up to date on this particular workflow state. This client feed is 
useful for content authors and managers who only have access to particular workflow states. 

 

Using the RSS Feeds 

When you have subscribed to a workflow feed, you can use the RSS Feed to perform the tasks that 
you have permission for. 

For example, in the following feed: 
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The user can: 

 Approve or reject the item. 

 Approve or reject the item and insert a comment. 

 Edit the item. 

If you click Reject & comment, the following page appears: 

 

Enter your comment and then click Reject to send the item back to the previous workflow state. 

Important 
You must select the Remember me check box on the Sitecore login page to perform these tasks 
without having to log in.  

If you haven‘t selected the Remember me check box, you must log in before you are directed to the 
appropriate page.  
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7.3 Security and Client RSS Feeds 

RSS technology is designed so that users who follow an RSS link can come directly to the item 
specified in the URL of the RSS feed. Most RSS readers do not support authentication. This means 
that users who subscribe to Sitecore client RSS feeds have direct access to the item specified in the 
URL of the RSS feed and do not have to identify themselves to the Sitecore security system when 
they view the RSS feed. However, the Sitecore security system verifies that they are authorized users 
when they try to perform any actions associated with the client feed. 

If someone else gains access to the URL of the RSS feed: 

 They can follow the link and view all the content contained in the RSS feed even though their 
own security permissions do not give them access to this item. 

 They cannot perform any actions on the content.  

 They cannot view any other content.  

 They cannot gain access to the username or password of the original owner of the RSS feed. 

 They cannot modify the link to gain access to any other content. 

Important 
Sitecore users should not share RSS feeds.  

To learn how to tighten security around RSS feeds, see the Sitecore Security Hardening Guide. 
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Chapter 8  

Workflows for Content Editors 

This chapter describes workflows, what you can use them for, and how they are 
implemented in Sitecore. There is also a description of the Workbox that reviewers 
use to move items through workflows. 

 Workflows 

 The Workbox 
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8.1 Workflows 

Workflows are a system that you can use in Sitecore to control when a content item is published. 

A workflow is a series of states that you define. These states should reflect the work processes and 
procedures that have been implemented in your organization for creating Web content. These states 
can correspond to the creation, review, and approval stages that content items must go through 
before they are published on your Web site. 

Workflows are a way of formalizing and enforcing these processes and procedures to ensure that only 
content items that have been approved are published.  

A workflow can contain any number of different workflow states and be as simple or complex as 
required. Content items do not necessarily have to pass through all the workflow states that you have 
defined — some states can be optional or only applicable for certain kinds of content. 

Furthermore, you can implement any number of different workflows. Each workflow must contain one 
workflow state that has been defined as the final workflow state. 

Content items must pass through the appropriate workflow states and can only be published when 
they are in the final workflow state. 

8.1.1 Implementing Workflows 

Workflows are normally implemented by developers. It can however be useful for content authors to 
understand how they are constructed and implemented. 

Workflows consist of special items that are stored in the Sitecore content tree. 

A workflow consists of: 

A Workflow — the main item that contains all of the subitems that make up the workflow. 

Workflow States — the basic building blocks of the workflow. The workflow states represent the 
different stages in your content creation process. Content items that are sent through a workflow start 
in the initial workflow state and finish in the final workflow state. 

Workflow Commands — the actions that must be performed by the various contributors to move the 
content items from one workflow state to another. 

Workflow Actions — actions that are automatically performed on the content items when they are in 
particular workflow states or when particular workflow commands are executed. 

Here is an example of a workflow: 

 

After the workflow has been defined, the developer specifies which item templates are subject to the 
workflow. When they have done this, every time a content author creates or edits a content item that 
is based on one of these templates the content item is sent to the initial workflow state of this 
workflow.  
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Important 
Content items can only be published when they are in the final workflow state. 

8.1.2 Using Workflows 

After the workflow has been implemented, content authors must send the content items they create or 
edit through the workflow before they can be published. 

When you create a new content item, it is automatically placed in the initial workflow state. The 
content item remains in the initial workflow state until you use a workflow command to move it to 
another workflow state. 

If you edit an existing content item that is subject to a workflow, Sitecore creates a new version of this 
content item and places it in the initial workflow state. If you edit this content item again later, you edit 
the version that is in the workflow unless you specify that you want to edit another version. 

Important 
Content items that are edited by administrators are not subject to workflows. 

Sending Content Items through Workflows 

When you have finished editing the content item, you can send it to the next workflow state. 

To send a content item to the next workflow state: 

1. In the Content Editor, open the content item that you are working on. 

2. When you are satisfied that it can be sent on through the workflow, click the Review tab. 

 

As you can see, the Workflow group displays a workflow command — Submit. This is the 
only workflow command that you can apply to the current content item in its present workflow 
state.  

Furthermore, the content item also displays a message informing you that this version of the 
item cannot be published because it is not in the final workflow state. 

3. Click Submit to send the content item to the next workflow state. Sitecore displays a dialog 
box for you to enter a comment: 

 

4. Enter a comment and then the content item is moved to the next workflow state.  
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The workflow commands that are available in the Workflow group change to reflect the item‘s 
new status. 

 

However, if you do not have permission to edit the content item in this workflow state, you 
cannot lock the item for editing and the workflow commands will not be displayed. 

Sitecore also contains a Workbox that been designed to give reviewers a greater overview of all the 
content items that are currently in workflows. 



Sitecore CMS 6.2 Content Author's Reference and Cookbook   

 

Sitecore® is a registered trademark. All other brand and product names are the property of their respective holders. The 
contents of this document are the property of Sitecore. Copyright © 2001-2010 Sitecore. All rights reserved.  

Page 100 of 115 

8.2 The Workbox 

The Workbox is a tool for reviewers and managers and gives them the overview they need to perform 
their tasks. 

Using the Workbox 

When you need to review content items, you should use the Workbox to see all the content items that 
are currently in workflows and which workflow states they are in. 

To use the Workbox: 

1. Log in to the Sitecore Desktop. 

2. Click Sitecore, Workbox: 

 

In the Workbox, you can see that the Sample Workflow has been selected and you can see 
all the relevant workflow states. You can also see that there is one content item in the 
Awaiting Approval workflow state. 

3. In every workflow state, you can preview, open, compare, each content item as well as apply 
the workflow commands that have been defined for that workflow state.  

In the Awaiting Approval workflow state, you can approve, or reject the content item. 

Previewing an Item 

To preview the version of a content item that is in a workflow state, click Preview and this version of 
the item is displayed in a new browser window.  

Opening an Item 

To open a content item, click Open and the item is opened in the Content Editor. 
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Comparing an Item 

To see the changes that have been made to a content item, click Diff.  

 

The Compare Versions dialog box lets you see the changes that have been made to this version of 
the item. You can select which versions to compare and whether you want them displayed in one or 
two columns. 

Approving or Rejecting an Item 

When you are finished reviewing the content item, click approve or reject to move it to the appropriate 
workflow state. 

Several Workflows 

If you have implemented more than one workflow, you can view them at the same time or switch 
between the different workflows in the Workbox. 

 

To display or hide a workflow in the Workbox, select or clear the check boxes in the Workflows 
group. You can also expand and collapse each workflow and workflow state. 
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Chapter 9  

Customizing the Interface 

You can change the interface in Sitecore. This chapter describes how to increase 
usable screen space, customize the interface in the Content Editor and in the Page 
Editor. There is also a description of how to customize the Sitecore Desktop. 

This chapter contains the following sections: 

 Working with the Browser 

 Customizing the Content Editor 

 Customizing the Page Editor 
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9.1 Working with the Browser 

All of the interfaces and programs that Sitecore contains are displayed in a normal Web browser.  

9.1.1 Full Screen Mode 

If you need to see more of the Web page or item that you are editing because there are too many 
elements in the way or because you are using a computer with a small screen, you can gain some 
space by expanding the browser interface to full screen mode. 

To enable full screen mode, press F11. This expands the browser window to fill the entire screen and 
hides the user interface elements of the browser — the title bar, menus, toolbar and status bar. 

To see some of hidden user interface elements, move your mouse to the top of the screen. Press F11 
again to restore the hidden browser user interface elements and exit full screen mode. 

9.1.2 The Sitecore Desktop 

When you are using the Sitecore Desktop application you can change some of the settings that affect 
the way Sitecore looks and customize other settings to suit your needs. 

In the Sitecore Desktop, you can: 

 Change the desktop background. 

 Change your password. 

 Change the application options. 

 Change your personal information. 

 Change the language settings. 

Changing the Desktop Background 

You can change the image displayed as your desktop background when you log in to the Sitecore 
desktop. 

To change the desktop background: 

1. Log in to the Desktop. 

2. Click the Sitecore menu and then click Control Panel, Preferences: 
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3. In the Preferences dialog box, click Change Your Desktop Background. 

 

4. In the Background field, select the image that you want to use. 

5. In the Position field, use the drop down arrow to select how you want to place the image on 
the desktop. 

6. In the Color field, select the color you want to surround the image if it does not fill the screen. 

Changing Your Password 

To change your password: 

1. In the Sitecore Desktop, click the Sitecore menu and then click Control Panel, Preferences. 

2. In the Preferences dialog box, click Change Your Password. 

 

3. In the Change Password dialog box, enter your current password and then enter and confirm 
your new password. 



Sitecore CMS 6.2 Content Author's Reference and Cookbook   

 

Sitecore® is a registered trademark. All other brand and product names are the property of their respective holders. The 
contents of this document are the property of Sitecore. Copyright © 2001-2010 Sitecore. All rights reserved.  

Page 105 of 115 

You can also change your password in the Sitecore log in page. 

 

Changing your Personal Information 

To change your personal information: 

1. In the Sitecore Desktop, click the Sitecore menu and then click Control Panel, Preferences. 

2. In the Preferences dialog box, click Change Your Personal Information. 

 

3. In the Personal Information dialog box, you can change your name, e-mail address, and the 
image that is used as your portrait throughout Sitecore. 

Changing Your Regional and Language Options 

To change your regional and language options: 

1. In the Sitecore Desktop, click the Sitecore menu and then click Control Panel, Preferences. 
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2. In the Preferences dialog box, click Set Your Regional and Language Options. 

 

3. In the Regional and Language Settings dialog box, you can: 

o Select the formats that you want to use for numbers, currencies, times, and dates. 

o Select the language that you want the client application to use. 

Using the Default Settings 

To use the default settings: 

1. In the Sitecore Desktop, click the Sitecore menu and then click Control Panel, Preferences. 

2. In the Preferences dialog box, click Reset My Settings to Default values. 
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9.2 Customizing the Content Editor 

The Content Editor contains a number of user interface elements that you can. 

You can, for example, give yourself more room to work in by: 

 Customizing the ribbon. 

 Customizing the content tree. 

 Resizing the editing pane. 

9.2.1 Customizing the Ribbon 

There are several ways in which you can customize the ribbon. 

You can: 

 Hide the ribbon. 

 Hide the tabs. 

 Create your own toolbar 

Hiding the Ribbon 

To hide the ribbon in the Content Editor:  

1. Double-click any tab to hide the ribbon. 

 

The ribbon is removed but the tabs are still displayed. 

2. Click on a tab to open that tab and display the ribbon again. 

Hiding Tabs 

You can also specify which tabs are displayed in the Content Editor. 

To hide a tab: 

1. Right-click anywhere on the ribbon to open a dialog box: 

 

2. Select or clear the check boxes to decide which tabs you want displayed in Content Editor. 
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3. Click reset to restore the default tab selection. 

Creating your own Toolbar 

You can also create your own toolbar that only contains the tools and functionality that you need to do 
your work. 

To create your own toolbar: 

1. Right-click anywhere on the ribbon and click Customize to open the Customize My Toolbar 
dialog box. 

 

1. In the All pane, expand the groups and select the commands that you want on your toolbar. 

You can only select commands and not groups. You can however insert separators to divide 
them into groups and use the up and down arrows to place the commands in the order you 
want. 

 

2. When you are finished, click OK. 
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3. Right-click on the ribbon to open the tabs dialog box and select the My Toolbar tab. The tab 
is added to the ribbon and contains all the command that you just selected. 

 

9.2.2 Customizing the Content Tree 

In the Content Editor, you can easily resize the content tree pane or hide the content tree entirely if 
you prefer. 

Hiding the Content Tree 

To hide the content tree: 

1. In the Content Editor, click the View tab. 

 

2. Clear the Content Tree check box to hide the content tree. 

3. Clear the Entire Tree check box to hide the root of the content tree (sitecore) and the media 
library. This view ensures that users can only see the items that are part of their Web site. 

4. Clear the Hidden Items check box to hide some of the system items that are displayed in the 
content tree. 

The other two settings — Raw Values and Standard Fields are only relevant for 
administrators. 

Resizing the Content Tree 

You can also resize the content tree. This can be useful when you need to find an item or when the 
pane takes up too much space. 

To resize the content tree: 

1. In the Content Editor, move the mouse over the bar between the Content Tree and the 
Editing pane. 

2. Drag the bar to the left or right to resize the elements in the window. 
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Configuring the Quick Action Bar 

The Quick Action Bar runs down the side of the content tree and can be used to display information 
that can be useful to both the content author and the administrator. 

 

To configure the Quick Action Bar 

1. Right-click the Quick Action Bar to see a list of the elements that it can display. 

 

2. Click an item in the menu to hide or display an icon beside the item that is affected.  

You can select the following items: 
 

Menu Item Tells you 

My Locked Items Which items you have locked. 

Locked Items Which items have been locked by another user and 
who locked it. 

Workflow State The workflow state of the item. 

Broken Links Which items contains broken links. 

Missing Versions Which items are missing a version. 

Published Warnings Which items have published warnings. 

Validation Rules Which items contain validation errors. 

Note 
The items that are available in this menu in your Sitecore solution may vary from the ones shown 
here. This is controlled by your Sitecore system administrator. 

You can select as many of these options as you like. There is a performance overhead to pay for 
each of these options. 

Important 
The Validation Rules and Broken Links options are the most costly of the Quick Action Bar options. 
Each time you open an item in the content tree the client must make a server call to refresh these 
options.  
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9.2.3 Changing the Application Options 

When you are using the Content Editor, you can also specify which elements of the Content Editor 
application should be displayed. 

To configure the Content Editor: 

1. In the Content Editor, click on the Sitecore button in the top left-hand corner. 

 

Alternatively, in the Sitecore Desktop, click the Sitecore menu and then click Control Panel, 
Preferences. 

2.  Click Application Options to open the Application Options dialog box. 

 

3. Select or clear any of the check boxes to hide or show the element in question. 
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The following screenshot points out where most of these elements are found in the Content Editor: 

 

The remaining elements in the Show/Hide section are: 

 Fields from Standard Template — selecting this option will display a large number of fields 
that are used internally by Sitecore. These are hidden to improve performance. 

 Use Smart Tags — an alternate way to show the commands associated with a field. 

 

 Prefetch Collapsed Sections — the system fetches and keeps the fields from the Field 
Sections in memory before the section is even opened. 

The other important option on the Content Editor tab is in the Pages section — Show Pages Bar. 

This option determines whether or not the shortcuts to the Sitecore applications are displayed at the 
bottom of the screen. 
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The View tab of the Application Options dialog box contains a few more options. 

 

In the Content Tree – Item Names section, you can specify whether you want the content tree to 
show the key that each item has or to show the language specific display name that you can give an 
item. 

In the Content Tree Root section, you can specify whether or not you want the content tree shown in 
the Content Editor and whether or not you want the entire content tree shown. 

Setting the Display Name of an Item 

To set the display name of an item: 

1. In the Content Editor, select the item in the content tree. 

2. On the Home tab, in the Rename section, click Display Name. 

3. When you are prompted, enter the name that you want displayed in the dialog box that 
appears. 

4. Refresh the content tree and the display name is visible: 

 

In the Content pane, the key is shown after the display name. 

Furthermore, the display name is also used for the item in the published Web site. 
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9.3 Customizing the Page Editor 

You can also customize the Page Editor. However, because the Page Editor contains limited 
functionality there is not that much that you can change about it. 

9.3.1 Working with the Ribbon 

The functionality that is available to you in the Page Editor is determined by the roles that your site 
administrator has assigned you. 

Hiding the Ribbon 

If you only have limited access to the functionality contained in the Page Editor, you can hide the 
ribbon to give yourself more space to work with. 

To hide the ribbon: 

1. Log in to the Page Editor. 

 

2. Click the Ribbon button at the top of the screen to hide the ribbon. 

3. When you need to use the ribbon, click Ribbon and it appears again. 

Changing the Interface 

If you have access to more functionality in the Page Editor, you can also change the way the Page 
Editor presents editable items to you. 

To change the interface: 

1. Log in to the Page Editor. 
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2. In the Page Editor, click the View tab. 

 

3. In the View tab, select or clear the check boxes to: 

o Specify whether or not the items are editable. 

o Whether or not the editable items are displayed in a floating frame. 

o Whether or not a dot is displayed beside the editable items. 
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